
 

 

 

 

 

 

Low-mobility Tracked Vehicle Tutorial 

(Track_LM) 

 

 

 

  



Copyright © 2020 FunctionBay, Inc. All rights reserved. 

User and training documentation from FunctionBay, Inc. is subjected to the copyright laws of 

the Republic of Korea and other countries and is provided under a license agreement that 

restricts copying, disclosure, and use of such documentation. FunctionBay, Inc. hereby grants 

to the licensed user the right to make copies in printed form of this documentation if provided 

on software media, but only for internal/personal use and in accordance with the license 

agreement under which the applicable software is licensed. Any copy made shall include the 

FunctionBay, Inc. copyright notice and any other proprietary notice provided by FunctionBay, 

Inc. This documentation may not be disclosed, transferred, modified, or reduced to any form, 

including electronic media, or transmitted or made publicly available by any means without 

the prior written consent of FunctionBay, Inc. and no authorization is granted to make copies 

for such purpose. 

Information described herein is furnished for general information only, is subjected to change 

without notice, and should not be construed as a warranty or commitment by FunctionBay, 

Inc. FunctionBay, Inc. assumes no responsibility or liability for any errors or inaccuracies that 

may appear in this document. 

The software described in this document is provided under written license agreement, 

contains valuable trade secrets and proprietary information, and is protected by the copyright 

laws of the Republic of Korea and other countries. UNAUTHORIZED USE OF SOFTWARE OR 

ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION. 

 

Registered Trademarks of FunctionBay, Inc. or Subsidiary 

RecurDyn is a registered trademark of FunctionBay, Inc. 

RecurDyn/Professional, RecurDyn/ProcessNet, RecurDyn/Acoustics, RecurDyn/AutoDesign, 

RecurDyn/Bearing, RecurDyn/Belt, RecurDyn/Chain, RecurDyn/CoLink, RecurDyn/Control, 

RecurDyn/Crank, RecurDyn/Durability, RecurDyn/EHD, RecurDyn/Engine, 

RecurDyn/eTemplate, RecurDyn/FFlex, RecurDyn/Gear, RecurDyn/DriveTrain, 

RecurDyn/HAT, RecurDyn/Linear, RecurDyn/Mesher, RecurDyn/MTT2D, RecurDyn/MTT3D, 

RecurDyn/Particleworks I/F, RecurDyn/Piston, RecurDyn/R2R2D, RecurDyn/RFlex, 

RecurDyn/RFlexGen, RecurDyn/SPI, RecurDyn/Spring, RecurDyn/TimingChain, 

RecurDyn/Tire, RecurDyn/Track_HM, RecurDyn/Track_LM, RecurDyn/TSG, RecurDyn/Valve 

are trademarks of FunctionBay, Inc. 

 

Edition Note  

This document describes the release information of RecurDyn V9R4. 

  



Table of Contents 

Getting Started ....................................................................... 5 

Objective ............................................................................................... 5 

Audience ................................................................................................ 6 

Prerequisites ........................................................................................... 6 

Procedures ............................................................................................. 6 

Estimated Time to Complete ..................................................................... 6 

Setting Up the Simulation Environment ...................................... 7 

Task Objective ........................................................................................ 7 

Estimated Time to Complete ..................................................................... 7 

Starting RecurDyn ................................................................................... 8 

Importing the Chassis Geometry ............................................................... 8 

Merging the Bodies .................................................................................. 9 

Defining the Track Componets.................................................. 11 

Task Objective ...................................................................................... 11 

Estimated Time to Complete ................................................................... 11 

Defining the Right Track Assembly .......................................................... 12 

Creating a Track Shoe ............................................................................ 13 

Creating a Sprocket ............................................................................... 15 

Creating a Set of Road Wheels ................................................................ 16 

Creating an Idler ................................................................................... 17 

Creating a Carrier Roller ......................................................................... 17 

Finishing the Track Subsystem ................................................. 19 

Task Objective ...................................................................................... 19 

Estimated Time to Complete ................................................................... 19 

Assembling the Track ............................................................................. 20 

Creating a Track Frame .......................................................................... 21 

Editing the Track Frame Body ................................................................. 21 

Creating the Carrier Holder ..................................................................... 21 

Creating a Tensioner Body ...................................................................... 22 

Creating Joints ...................................................................................... 23 

Adding a Motion Input ............................................................................ 23 

Validating the Track Subsystem Definition ................................................ 25 

Developing and Running the Full-vehicle Model .......................... 26 

Task Objective ...................................................................................... 26 

Estimated Time to Complete ................................................................... 26 

Adjusting the Subsystem Properties ......................................................... 27 

Positioning and Testing the Right Track Assembly ...................................... 27 

Creating the Left Track Subsystem .......................................................... 28 

Defining a Terrain ................................................................................. 29 



Track Subsystem Tuning (Optional) .......................................... 31 

Task Objective ...................................................................................... 31 

Estimated Time to Complete ................................................................... 31 

Adjusting the Track Assembly Parameters ................................................ 32 

Adjusting the Track Component Parameters ............................................. 33 

Setting Up a Mechanical Track Tensioner .................................................. 34 

Adding the Blade Linkage (Optional) ......................................... 36 

Task Objective ...................................................................................... 36 

Estimated Time to Complete ................................................................... 36 

Saving a New RecurDyn Model ................................................................ 37 

Importing and Aligning the Blade Assembly Geometry ............................... 37 

Adding Hydraulic Cylinders ..................................................................... 38 

Positioning the Hydraulic Cylinders .......................................................... 39 

Adjusting Size, Colors, and Motion of Hydraulic Cylinders ........................... 41 

Defining Constraints for the Blade Assembly ............................................. 42 

 

 



L O W - M O B I L I T Y  T R A C K E D  V E H I C L E  T U T O R I A L  ( T R A C K _ L M )  

 

5 

 

Getting Started 

Objective 

This tutorial introduces you with the Low-Mobility (LM) Track Transport Toolkit and how to 

simulate the behavior of tracked vehicles on rigid, soil, and snow terrains. You will learn how 

to define undercarriage components and track shoes. You will also learn how to efficiently 

define the assembled track that will wrap around the undercarriage components. The tutorial 

is made up several main chapters, followed by two optional exercises. You can choose to 

work through any of the optional exercises after creating the model as instructed in main 

chapters. 

The process that you will follow in the tutorial and the process automation tools that you will 

use to define the LM Track are similar to the processes and tools used to define belt/pulley 

and chain/sprocket subsystems. Therefore, the concepts that you learn while performing this 

tutorial will help you learn how to use the belt and chain toolkits more quickly. In addition, if 

you have already worked through a belt or chain tutorial, you will find this tutorial easier to 

work through than someone who has no experience with the belt or chain tutorials. 

The terms low-mobility and high-mobility refer to two different styles of tracked vehicles. The 

low mobility toolkit is focused on: 

▪ Tracked construction equipment with discrete steel shoes. 

▪ Track shoes that are defined as an extruded profile. 

▪ External guides that keep the track shoes from falling off of the rollers. 

▪ Single sprocket that contacts the shoes at their centers. 

The high-mobility toolkit is focused on: 

▪ Tracked military vehicles. 

▪ Track shoes that are defined as blocks with attached cleats. 

▪ Center guides on the track shoes that pass-through grooves in the roadwheels and the 

idler to keep the track shoes from falling off of the rollers. 

▪ Dual sprocket that contacts the shoes at the pins that protrudes from the sides of the 

track shoe.  

Chapter 

1 
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The names low-mobility and high-mobility refer to the vehicle’s speed of operation. Typically, 

construction equipment operates at a slower (or low) speed while the military equipment 

operates at a fast (or high) speed, especially during transport. 

 

Audience 

This tutorial is intended for experienced users of RecurDyn 

Prerequisites 

Users should first work through the 3D Crank-Slider Tutorial and the Engine with Propeller 

Tutorial 

Procedures 

The tutorial is comprised of the following procedures. The estimated time to complete each 

procedure is shown in the table. 

Procedures  Time (minutes) 

Simulation environment setup 15 

Track component definition 35 

Track subsystem completion 15 

Full-vehicle model development 15 

Subsystem tuning(optional) 20 

Addition of blade linkage(optional) 30 

Total 130 

 

Estimated Time to Complete  

2 hours 
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Setting Up the Simulation 

Environment 

In this chapter, you will start RecurDyn and set up its environment, including importing the 

completed bulldozer chassis with cab. You will also merge the imported geometry into one 

body and set its center of mass. 

Task Objective 

Learn to set up the RecurDyn environment and import data. 

 

Estimated Time to Complete 

15 minutes 

  

Chapter 

2 
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Starting RecurDyn 

To start RecurDyn and create a new model: 

1. On your Desktop, double-click the 

RecurDyn icon. 

RecurDyn starts and the Start RecurDyn 

dialog box appears. 

2. Ensure the units are the same as those 

shown in the Start RecurDyn dialog box to 

the right.  If not, click MMKS. 

3. Change the model name to 

LM_Track_Tutorial as shown in the 

window, and then click OK. 

 

4. Set the grid spacing to 10 mm. 

 

 

 

Importing the Chassis Geometry 

You will begin to model the tracked vehicle by importing an already completed bulldozer 

chassis. 

To import the chassis geometry: 

1. From the File menu, choose Import.  

2. In the Open dialog box, set file type to 

ParaSolid File, and from the Track LM 

Files folder, select the file Chassis.x_t as 

shown in the dialog box on the right.         

(The file location: <Install Dir> /Help 

/Tutorial /Toolkit /Track_LM 

/LowMobilityTrackedVehicle, ask your 

instructor for the location of the directory if 

you cannot find it).   
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3. Click Open. The CAD Import Options window appears. Clear the Assembly 

Hierarchy checkbox and click the Import button. 

 

The bulldozer chassis appears as shown below after rotating it and setting the render 

mode to Shade with wire. 

 

Merging the Bodies 

The chassis is made up of five bodies. You are going to merge them into one body to make it 

easier to work with the chassis. In addition, you are going to change the center of mass to 

reflect the new merged body.  
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To merge the bodies: 

1. From the Tools group in the Home tab, click 

Merge. 

 

 

2. Select all the bodies in the Merge Body dialog 

box.  

3. Enter ImportedBody1 as the target body, either 

by typing the name into the Target Body text 

box or by clicking the B (Body) button and clicking 

the cab geometry. The target body is the body 

into which all the bodies will be merged. 

4. Check the User Input in Material Input option 

to set the Body Material Type to User Input. 

5. Click OK.  

 

 

 

6. Display the Property dialog box for the merged body, ImportedBody1 and do the 

following: 

 

Tip: In the Database window, right-click ImportedBody1 and click Property.  

▪ Click the General tab, if necessary, and change the name of ImportedBody1 to 

Chassis. 

▪ Click Apply. 

▪ From the Body Tab, Click CM and change the Origin to -1400, 500, 0.  

▪ Click OK to close the CM dialog box.  

▪ Click OK again to close the Chassis Properties dialog box. 

7. Save the RecurDyn model as LM_Track_Tutorial.rdyn. 
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Defining the Track Componets 

In this chapter, you will define the objects that make up the track using the TrackLMSub1 

tools. In the next chapter, you will assemble the objects together. The objects that you will 

create are shown below 

Task Objective 

Learn to create the objects that define a track and understand the process of creating a track 

using the Track LM tools. 

Estimated Time to Complete 

35 minutes 

  

Chapter 

3 
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Defining the Right Track Assembly 

You will create a low-mobility track subsystem which then provides you with access to 

standard entities in the LM Track Transport Toolkit, such as: 

▪ Sprockets 

▪ Rollers used to define road wheels, idlers, and carrier rollers 

▪ Track links, lateral guards for the track, and a terrain builder 

To define a new low-mobility track subsystem: 

▪ From the Subsystem Toolkit group in the Toolkit tab, click the Track (LM). 

After RecurDyn creates the subsystem, it is in Subsystem Edit mode. The name in the upper 

left of the graphics window is TrackLM1@LM_Track_Tutorial and the top node in the 

Database window is TrackLM1. 
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Creating a Track Shoe 

You will create a track shoe and define the grouser profile by importing a set of xy data 

points. You could create the set of points by exporting a profile from your CAD software or by 

calculating the points in Excel.  The points are simply exported as two columns that are 

separated by a delimiter, such as a comma or a space. You should change the extension of 

the file name to .mat.  

To create a track shoe: 

1. From the Link group in the Track (LM) tab, click the Link. (This procedure proceed in 

the subsystem edit mode named TlackLM1) 

 

 

2. Click the location -1400, -900, 0. 

3. In the TrackLink dialog box, click the 

Geometry Data tab and fill in the text 

boxes as shown in the dialog box on the 

right.  You will adjust the: 

▪ Pin Radius: 24 

▪ Track Link Left Length: 119.5  

▪ Track Link Right Length: 119.5 

▪ Left Pin Position: -88.5, 39 

▪ Right Pin Position: 88.5, 39  

▪ Grouser Width: 460  

4. To view a graphical description of the 

geometry data, click Dimension 

Information. 

5. Keep the TrackLink dialog box open. 

To import a new track link grouser profile: 

1. In the TrackLink dialog box, 

click the Grouser Profile 

tab, and then click Import.  

2. Select the Grouser1 file 

(.mat file extension may or 

may not be visible) from the 

Track LM Files directory 

(The file location: <Install 

Dir> /Help /Tutorial /Toolkit 

/Track_LM 

/LowMobilityTrackedVehicle) 

and click Open. 
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The grouser coordinates appear as 

shown at the right. 

3. Click Draw to display the grouser 

profile as shown.  

As you review the grouser profile, you 

will see that nodes (points) 7 through 

19 cover the section of the grouser that 

will contact the terrain. You want those 

nodes to be included in the contact 

calculations for hard terrains.  

4. In the spreadsheet of the TrackLink 

dialog box, check the boxes under the 

Shoe column for points 8, 10, 12, 14, 

16, and 18. 

5. To set up the grouser points, in the 

Shoe Point section, click Define. 

 

You also want to set up the contact calculations for 

soft terrains (soils, sands, snow, and so on). 

6. In the TrackLink dialog box, set the Start Node to 

7 and the End Node to 19 in the Grouser Mesh 

section. 

7. Click OK to exit the TrackLink dialog box. 

 

8. Display the TrackLink1 Property dialog box and set 

its color to light gray (Graphic Property tab).   

9. Click OK. 
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Creating a Sprocket 

To create a sprocket: 

1. From the Sprocket group in the Track (LM) tab, click the Sprocket. 

 

 

2. Click the location -2900, 0, 0. 

3. In the Sprocket dialog box, click the Geometry Data tab.  

4. Click Dimension Information to see the meaning of the various entries. 

5. Fill in the text boxes as shown in the 

dialog box on the right. You will adjust 

the:  

▪ Number of Teeth: 26 

▪ Dedendum Circle Radius 

(Rd): 339 

▪ Base Circle Radius (Rb): 344 

▪ Pitch Circle Radius (Rp): 365  

▪ Addendum Circle Radius 

(Ra): 375 

▪ Pin Circle Radius (Rp): 24 

▪ Loop Radius: 365 (typically 

the same as the pitch circle 

radius) 

6. Keep the dialog box open.  

To import a new sprocket tooth profile:   

1. In the Sprocket dialog box, click the Tooth Profile tab, and then click Import.  

2. Select the sprocket1 file (.mat file extension may or may not be visible) from the 

Track LM Files directory. 

(The file location: <Install 

Dir> /Help /Tutorial /Toolkit 

/Track_LM 

/LowMobilityTrackedVehicle)  

3. Click Open. 

4. Click OK.  

5. Display the Sprocket Property 

dialog box and set the color 

of the sprocket tooth profile 

to yellow (Graphic 

Property tab).   

6. Click OK.  
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Creating a Set of Road Wheels 

In this section, you will create six road wheels, as 

shown in the figure on the right. You will set their 

properties and change their names.  

To create a set of road wheels: 

1. From the Flange group in the Track (LM) tab, click Single.   

 

 

2. Create six road wheels with centers at the locations specified in the table below.  You 

can create each road wheel individually and modify its properties individually, or you can 

create one road wheel, modify its properties, make a copy, move it to the correct 

position and repeat for the six road wheels. If copying, remember to turn off the Shift 

when Pasting option (see Home Tab→Setting Group→Display→Advanced). In the 

next step, you will rename the road wheel names as listed in the table. 

Set the single 

flange 

To point 

(X,Y) 

With a distance 

(radius) 

X offset (if 

copying) 

Change name 

to Road Wheel 

# 

SingleFlange1 -2460, -250 70  6 

SingleFlange2 -2220, -250 70 240 5 

SingleFlange3 -1930, -250 70 290 4 

SingleFlange4 -1640, -250 70 290 3 

SingleFlange5 -1350, -250 70 290 2 

SingleFlange6 -1110, -250 70 240 1 

 

3. Display the Properties dialog box for 

each road wheel. 

▪ Click the Characteristics tab and 

set the parameters to be the same 

as in the figure and listed below:  

▪ Hub Radius (Rh): 40 

▪ Flange Radius (Rf): 80  

▪ Change their color to green.  

▪ Rename them from 

SingleFlange1 through 

SingleFlange6 to RoadWheel_6 

through RoadWheel_1, renaming 

them in descending order, as 

shown in the table above. 
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Creating an Idler 

To create an idler: 

1. From the Flange group in the Track (LM) tab, click the Center. 

 

2. Create a flange with a center at -700, 0, 0. 

and a radius (distance) of 320 (enter it in the 

Command Toolbar text box or drag the 

mouse horizontal or vertical until the readout 

is 320).  

3. Display the CenterFlange1 Properties dialog 

box to set the color of the idler to yellow 

(Graphic Property tab).   

4. Click the Characteristics tab and set Inner 

Flange Radius (Rf) to 350.  

5. Click the General tab and set the name to 

Idler. 

6. Click OK. 

Creating a Carrier Roller 

To create a carrier roller: 

1. From the Flange group in the Track (LM) tab, click the Center. 

 

2. Create a flange with a center at -1780, 360, 

0 and a radius (distance) of 45 (enter it in 

the Input Window text box).  

3. Display the CenterFlange1 Properties 

dialog box to set the roller color to green 

(Graphic Property tab).   

4. Click the Characteristics tab and set Inner 

Flange Radius (Rf) to 60. 

5. Click the General tab and change the name 

to Carrier. 

6. Click OK. 
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Your track subsystem should look like the figure below (rotated, and with the render mode 

set to Shade With Wire). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You are now ready to assemble the track.   
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Finishing the Track Subsystem 

In this chapter, you will complete the modeling of the subsystem by creating the track, 

creating the track frame geometry and attaching the track components to the track frame. 

You will add a motion to the sprocket and be prepared to simulate the behavior of the track 

subsystem. 

Task Objective 

Learn to assemble a track, create a track frame, and attach the track components to the 

track frame. 

Estimated Time to Complete 

30 minutes 

  

Chapter 

4 
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Assembling the Track 

To assemble the track: 

1. From the Assembly group in the Track (LM) tab, click the Assembly. 

 

 

2. Starting with the sprocket, select each item in the track in a counterclockwise order until 

you have completed the loop as shown in the figure following.   

 

When you are done, a dialog box appears as shown on the right. 

 

3. Click OK and RecurDyn adds the components to the 

database. 
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Creating a Track Frame 

To create a track frame body: 

1. From the Marker and Body group in the Professional tab, click the Link. 

 

 

2. Click the following two points to create the link. 

▪ -2325, -80, 0  

▪ -1260, -80, 0 

Editing the Track Frame Body 

To edit the track frame body: 

1. Enter Body Edit mode for the link body you 

just created by either. 

▪ Double-clicking on the geometry of the 

body that you just created. 

▪ In the Database window, right-clicking 

Body1, and selecting Edit. 

2. Display the Properties dialog box for the link 

geometry and do the following. 

▪ Change the First Radius and Second 

Radius values to 200 and the Depth to 

20.  

▪ Click OK.  

 

Creating the Carrier Holder 

To create the carrier holder: 

1. From the Marker and Geometry group in 

the Geometry tab, click the Link. 

 

 

2. Click the following two points to create the 

link. 

▪ -1780, 0, 0 

▪ -1780, 350, 0 

3. Display the Properties dialog box for the second link geometry and do the following. 

▪ Change the First Radius and Second Radius values to 50 and the Depth to 20.   
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▪ Click OK.   

4. Click the Exit arrow to exit Body Edit mode and return to the subsystem. 

 

 

5. Display the Properties dialog box for this body and:  

▪ Set the name to Track_Frame. 

▪ In the Graphic Property tab, change the color to orange.  

▪ Click OK. 

Creating a Tensioner Body 

To create a tensioner body: 

1. From the Marker and Body group in the Professional tab, click the Box.   

2. Click on the following two points to create the box. 

▪ -1300, 100, 0 

▪ -700, -100, 0 

3. Double-click the tensioner to enter Body Edit mode.   

4. Display the Properties dialog box for the tensioner and do the following. 

▪ In the Box tab, change Depth to 40. 

▪ In the Origin & Orientation tab, change Origin to (-1000, 0, -20).  

5. Click OK. 

6. Click the Exit arrow to return to the subsystem edit mode. 

7. Display the Properties dialog box for the tensioner and do the following. 

▪ Click the General tab, if necessary, and set the name to Tensioner. 

▪ Click the Graphic Property tab and change the color to Aqua. 

8. Click OK. 

The track assembly now appears as shown in 

the figure on the right. 
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Creating Joints 

In this section, you will create a series of revolute and fixed joints to properly attach the 

sprocket, road wheels, idler, and carrier to the track frame to the Mother Body (local ground 

in subsystem). 

To create joints:  

▪ Using the tools of the Joint group in the Professional tab, create the following joints as 

specified in the table below. Use the Body, Body, Point option for joints located away from 

the body geometry. 

 

 

 

 

 

 

 

 

 

Adding a Motion Input 

In this section, you are going to add a motion input to the revolute joint of the sprocket that 

smoothly brings the sprocket velocity up to one revolution per second (360 degrees per 

second). The velocity will begin to ramp up at 0.1 seconds and will be fully developed at 1.0 

second. 

Create the joint 

of type 

First Body Second Body At the location 

Revolute Sprocket1 MotherBody -2900, 0, 0 

Revolute Idler Tensioner  -700, 0, 0 

Revolute RoadWheel_6 Track_Frame -2460, -250, 0 

Revolute RoadWheel_5 Track_Frame -2220, -250, 0 

Revolute RoadWheel_4 Track_Frame -1930, -250, 0 

Revolute RoadWheel_3 Track_Frame -1640, -250, 0 

Revolute RoadWheel_2 Track_Frame -1350, -250,0 

Revolute RoadWheel_1 Track_Frame -1110, -250,0 

Revolute Carrier Track_Frame -1780, 360,0 

Fixed Tensioner Track_Frame -1200, 0, 0 

Fixed Track_Frame Mother Body -1780, 0, 0 
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To add a motion input:   

1. Right-click the revolute joint at the center of 

the sprocket (RevJoint1) and click 

Properties. 

2. Check the Include Motion check box. 

3. Click Motion button. 

4. Set the unlabeled pull-down menu to 

Velocity.  

5. Click EL to view the Expression List.  

6. Click Create to create an expression. 

7. Change the expression name to 

Exp_Sprocket_Vel, and define the 

expression as: 

▪ STEP(TIME, 0.1, 0, 1, 360D) 

8. Click OK four times to exit all the way out of 

the Joint Properties dialog box. 
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Validating the Track Subsystem Definition 

In this section, you will run a simulation to validate the subsystem. The track system is fixed 

in space and there is no terrain for the track to contact. You will be able to see the sprocket 

motion and the motion of the track over the road wheels, idler, and carrier. 

To validate the subsystem:   

1. Run a simulation for 5 seconds and 250 steps.   

 

 

2. View the animation by using the animation control buttons. 

 

3. Select the Exit arrow to go to the assembly mode. 
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Developing and Running the Full-

vehicle Model 

In this chapter, you will develop a full-vehicle model by making a copy of the completed track 

system and attaching both track subsystems to the chassis. You will build a terrain and then 

run the tracked vehicle over the terrain. 

Task Objective 

Learn to combine two subsystems with other geometry at the main model level and how to 

define a terrain. 

Estimated Time to Complete 

30 minutes 

  

Chapter 

5 
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Adjusting the Subsystem Properties 

There are two subsystem properties that you must adjust at the model level: 

▪ Change the name of the subsystem to make it easier to identify.  

▪ Define the mapping so the Mother Body in the subsystem corresponds to the Chassis 

body at the Model level. This mapping is very useful because it helps you simulate the 

subsystem in a fixed position (attached to the Mother Body) while also properly attaching 

the subsystem to the Chassis when you simulate at the Model level.  

To adjust the subsystem properties: 

1. Display the Properties dialog box for 

TrackLM1 subsystem.   

2. Click the General tab and change the name 

of the subsystem to Right_Track_Assy.  

3. Display the Properties dialog box for the track 

subsystem.  

4. In the Subsystem tab, change the Mother 

Body to the Chassis body. 

5. Click OK.   

 

 

 

Positioning and Testing the Right Track Assembly 

You will move the right track subsystem into position with respect to the chassis.  

To position the subsystem: 

▪ Select the Right_Track_Assy subsystem, and display the Basic Object Control dialog 

box to move the subsystem:  

▪ Enter 250 mm in the Offset Value text box and click +X.  

▪ Enter 300 mm in the Offset Value text box and click –Y.  

▪ Enter 1000 mm in the Offset Value text box and click +Z. 

To test the subsystem: 

1. Add a fixed joint between the chassis and ground to hold up the chassis for this test. The 

location of three fixed joint does not matter. 

 

2. Run a simulation for 5 seconds and 250 steps and compare the results to the previous 

animation. 
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Creating the Left Track Subsystem 

You will create the left track subsystem by making a copy of the existing track subsystem 

and by moving the new track subsystem to the other side of the chassis. You will then test 

this step.  

To create the left track subsystem: 

1. From the Setting group in the Home tab, click General.  

2. If needed, clear the selection of the box next to Shift When Pasting (you may have 

already cleared this box when you were creating the road wheels).  

3. Click OK to exit the General Settings dialog box.  

4. Select the right track subsystem, copy it, and paste it (this will take a few seconds).   

5. Display the Properties dialog box for the new track assembly and do the following: 

▪ Click the General tab, if necessary, and change the name to Left_Track_Assy.  

▪ Click the Origin & Orientation tab, and change Origin to 250, -300, -1000.   

▪ Click the Subsystem tab, and change Mother Body to Chassis.   

▪ Click OK. 

Your model should appear as shown on the right. 

 

 

 

 

 

 

 

To test the subsystem: 

▪ Run a simulation for 5 seconds and 250 steps and compare the results to the previous 

animation. 
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Defining a Terrain  

Edit the ground body and define a terrain.   

To define the terrain: 

1. To enter the ground edit mode, click the Ground of the 

Marker and Body group in the Professional tab. 

 

2. Click the Outline of the Curve group in the Ground tab. 

 

 

3. Create an outline by using the data in the table to the 

right.  

4. When you finish selecting the points, right-click and click 

Finish Operation. 

Tip: Another option is for you to create a dummy outline and 

import the coordinates from the file Terrain_Outline:f 

1. Create an outline with two points that are anywhere on the 

screen. Right-click and select Finish Operation. 

2. Right-click the outline and select Properties.  

3. Click Import and select the file Terrain_Outline(.mat file 

extension, The file location: <Install Dir>/Help/ 

Tutorials/Toolkit/Track_LM/LowMobilityTrackedVehicle). 

 

5. Make a copy of the outline (copy and paste) and move the 

outline 2500 mm in the +z direction and the first outline 

2500 mm in the –z directions.   

6. To create a terrain (road surface), click the Spline Road 

of the Road Data group in the Ground tab.  

 

 

7. Click the near outline, then the far outline, then right-click and click Finish Operation. 

▪ RecurDyn creates the road data entity. 

8. Select the Exit arrow to return to the 

assembly mode. 

The result is shown in the right figure. 

 

 

 

 

No. X Y 

1 -3,500 -1,600 

2 250 -1,350 

3 3,700 -250 

4 6,500 0 

5 9,050 -450 

6 11,450 -1,350 

7 13,950 -2,600 

8 15,750 -3,250 

9 16,850 -3,400 

10 20,100 -3,400 

11 20,500 -3,250 

12 21,050 -3,100 

13 21,450 -3,100 

14 21,850 -3,250 

15 22,350 -3,400 

16 24,600 -3,400 

17 29,200 -2,100 
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To test the full-vehicle model with the terrain: 

1. In the Database window, expand Joints, and right-click the 

name of the fixed joint (between the chassis and ground) that 

appears and select Inactive to make the joint inactive. 

The joint icon in the Database window and in the graphics 

window turns gray. You are making the fixed joint inactive to 

allow the bulldozer to drop down and make contact with the 

terrain. 

2. Run a simulation for 5 seconds and 250 steps and compare 

the results to the previous animation.  

3. Display the Plot window and plot the tension in the tracks by expanding the Track-

Force, expanding each track link entity and double-clicking Bushing Tension.  

 

4. If you have the time, run the simulation again, but this time for 12 seconds and 600 

steps. You will see that the bulldozer will traverse much of the terrain. 

5. Save the RecurDyn model. 

 

 

 

The remaining sections of the tutorial contain optional exercises. 
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Track Subsystem Tuning 

(Optional) 

In this chapter, you will consider a variety of topics related to the detailed modeling of 

tracked vehicles. In the earlier chapters of this tutorial, you accepted many default values as 

you created the track components and the track assembly. Here you will find out how to 

modify some interesting track system values. 

Task Objective 

Learn to work with the various value and parameters associated with the track assembly and 

the track components. As you use the LM Track toolkit to model your own products, you will 

adjust these parameters according to your engineering and test data to develop validated 

models. 

Estimated Time to Complete 

20 minutes 

  

Chapter 

6 
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Adjusting the Track Assembly 

Parameters 

When you execute the Track Assembly operation, RecurDyn creates a Track Assembly 

entity. It appears near the bottom of the Database window as shown in the figure on the 

right. Right-click the Track Assembly entity and click Properties to display its Properties 

dialog box. It contains several tabs, which are explained in the next sections.  

General Tab: 

Use the General tab to modify the Name of the Track Assembly. 

Characteristics 1 Tab: 

Use the following options: 

▪ Set track stiffness by clicking the Bushing 

Force.  

▪ Set the translational and rotational stiffness 

and damping values for all degrees of 

freedom for the two bushings used to 

connect each track link to the next.   

▪ Set the track tension by setting a preload in 

the Radial direction of the bushing force. 

▪ Define the interaction between the track 

and a soft soil (clays, sands, loams, even 

snow) by selecting Pressure-Sinkage and 

then clicking Contact Parameter. You can 

select the soil type from the select list and click Load to load the Bekker parameters for 

that soil. You can modify the parameters and save them to a file to create your own 

library of soils. 

Characteristics 2 Tab: 

The Characteristics 2 tab is used to define or 

modify the list of entities that the track 

contacts.  

▪ If you want to add another carrier roller, 

you will create the new roller and then use 

Navigation (for clicking from the graphics 

screen) or List to select the new roller from 

a list. 

▪ Use Grouser-to-Sphere Contact to select 

spheres that have been defined to 

represent rocks in the terrain or any other 

supplemental contact with the track. 

▪ Set the Initial Velocity of the track by 

checking Initial Velocity (x-axis) of Links 

box at the bottom of the dialog box and entering the desired initial velocity in the text 

box. 

  



L O W - M O B I L I T Y  T R A C K E D  V E H I C L E  T U T O R I A L  ( T R A C K _ L M )  

 

33 

 

Output Tab:  

You can use the Output tab to customize 

which track links have their outputs saved 

from the simulation. The default is to save 

only the data from the first link, TrackLink2. 

You can manually check the boxes or use 

Selection by Simple Rule to automate the 

selection of links according to a numbering 

increment.  

 

 

 

 

 

Adjusting the Track Component Parameters 

Contact between components and the track:  

The contact characteristics between any track 

wheel or sprocket to the track assembly can be 

different. For that reason, the contact 

parameters are set in the Contact 

Characteristic tab of each component. You can 

set the stiffness, damping, and friction according 

to the materials used in each component and the 

state of the component (that is, according to 

wear). 
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Setting Up a Mechanical Track Tensioner 

To create a mechanical track tensioner, do the following for each track subsystem. 

Replace the Fixed joint with a Translational joint: 

1. Enter the Right_Track_Assy subsystem edit mode. (if necessary) 

2. Delete the Fixed joint between the Track_Frame and the Tensioner by selecting the 

name Fixed1 in the Joints section of the database window, clicking the right mouse 

button with the cursor still over the name, and selecting the Delete option in the menu 

that pops up. 

3. Create a Translational joint between the Track_Frame and the Tensioner by 

selecting the Translate icon of the Joint group in Home the tab and selecting Body, 

Body, Point, Direction input method.  

▪ Body1: Track_Frame 

▪ Body2: Tensioner 

▪ Joint Origin Point: -1200, 0, 0 (Use markers remaining from Fixed joint) 

▪ Position Vector: Tensioner.Box1 (1,0,0) (Select the horizontal edge on the top 

of the Tensioner body or select the edge using the Flip List to orient the joint to be 

horizontal) 

Add a Tensioning Spring 

1. Add a Spring (of the Force group in the Professional tab) between the Track_Frame 

and the Tensioner (you can select the locations of the ends of the spring).  

▪ Body1: Track_Frame 

▪ Body2: Tensioner 

▪ Point 1: -1500, 0, 0 (on the Track_Frame) 

▪ Point 2: -1200, 0, 0 (on the Tensioner) 

2. Bring up the Properties of the Tensioner Spring by placing the cursor over the 

Spring1 in the Force group of the Database window, clicking the right mouse button, 

and selecting the Properties option. 

3. Under the Spring tab, set the parameters listed below. The spring is set to a low 

stiffness value so that the spring force remains close to a constant value as the 

Tensioner stretches the track. 

▪ Stiffness Coefficient: 0.1 

▪ Damping Coefficient: 100 

▪ Pre Load: 50000 

4. Under the Graphic tab, set the Spring Diameter to 50. 

5. Click OK to exit the Properties dialog box.    
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Validate the Track Tensioner 

1. Run a simulation for 5 seconds, 250 Steps, and with the Plot Multiplier set to 8. 

2. Play back the animation and you will see that the idler stretches forward by a small 

amount in response to the track tensioner.  

3. Open the plot window and 

open the Track-Force group, 

open the TrackLink2, plot the 

BushingTension. You will 

see that the average track 

tension is approximately 50% 

of the force in the Tensioner 

Spring (25,000 N).  The low 

tension occurs when 

TrackLink2 is in contact with 

the sprocket.  

4. Adjust the spring properties as 

needed to attain the desired 

track tension. 

5. Repeat what you just did (replace fixed joint by translation joint and spring) at 

Left_Track_Assy for next optional tutorial. 
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Adding the Blade Linkage 

(Optional) 

In this chapter, you will add a blade assembly (one blade and two side rails to the bulldozer 

model that you developed earlier. You will add hydraulic cylinders and the constraints needed 

to raise and lower the blade. You will run the updated bulldozer over the terrain.  

Task Objective 

Learn how to use predefined subsystems and how to add constraints between bodies at the 

model level and bodies in a subsystem. 

Estimated Time to Complete 

30 minutes 
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Saving a New RecurDyn Model 

Because this is an optional exercise, it is a good idea to save the RecurDyn model to a new 

file so that at a later time you can separately refer to the basic bulldozer model, as well as to 

the bulldozer model with a blade assembly. 

To save a new RecurDyn model: 

1. From the File menu, choose Save As.  

2. Enter the file name LM_Track_Blade.rdyn.   

Importing and Aligning the Blade Assembly Geometry 

The blade assembly consists of the blade and the two side rails. Once imported, the assembly 

needs to be moved into place with respect to the chassis. 

To import the blade assembly geometry:  

1. From the File menu, choose Import. 

(In the assembly mode). 

2. In the Open dialog box, set file type 

to ParaSolid File, and from the 

Track LM Files folder, select the file 

Blade_Assy.x_t as shown in the 

dialog box on the right. (The file 

location: <Install Dir> /Help 

/Tutorials /Toolkit /Trak_LM 

/LowMobilityTrackedVehicle , ask your 

instructor for the location of the 

directory if you cannot find it). 

3. Click Open. The CAD Import 

Options window appears. Clear the Assembly Hierarchy checkbox and click the 

Import button. 

 

 

To place the blade assembly geometry: 

Display the Basic Object Control window. 

▪ Make sure that ImportedBody1, ImportedBody2, and ImportedBody3 are selected. 

▪ Select the Rotate tab, set Degree to 180, and rotate about the global Y axis (in 

either direction) to flip the blade assembly around.   
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▪ Click the Translate tab, set the Offset Value to 

3500, and move the blade assembly in the –X 

direction.  

▪ Set the Offset Value to 200 and move the blade 

assembly in the –Y direction. 

The model should appear as shown in the figure on the 

right. 

 

To name the blade assembly bodies: 

▪ Display the Properties dialog box for each blade assembly body and rename each as 

follows. 

▪ ImportedBody1 to Right_Rail 

▪ ImportedBody2 to Left_Rail 

▪ ImportedBody3 to Blade 

Adding Hydraulic Cylinders 

A hydraulic cylinder consists of the upper cylinder body and a cylinder rod. It can be tedious 

to create and align the cylinder bodies with the two connecting points. Instead, you can 

import a hydraulic cylinder system and then position them using parametric points.  

To import the hydraulic cylinder subsystem: 

1. From the File menu, choose Import.  

2. In the Open dialog box, the file type should default to RecurDyn Subsystem File. If 

not, select that file type.  

3. From the Track LM Files folder, select the file Hydraulic_Cylinder.rdsb as shown in 

the dialog box. (The file location: <Install Dir>/Help / Tutorials /Toolkit /Track_LM 

/LowMobilityTrackedVehicle, ask your instructor for the location of the directory if you 

cannot find it). 

4. Click Open. 

The Import SubSystem window appears.  

5. Click OK to create the hydraulic cylinder subsystem.  

To create the second hydraulic cylinder subsystem: 

1. In the Database window, click the SubSystem1 and use the Copy and Paste 

commands to create a second hydraulic cylinder subsystem, C1_Subsystem1.  

2. Display the Properties dialog box for each subsystem and rename each as follows. 

▪ SubSystem1 to Left_Cyl 

▪ C1_Subsystem1 to Right_Cyl 
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Positioning the Hydraulic Cylinders 

There are parametric points in the hydraulic cylinder subsystems. The hydraulic cylinders will 

position themselves if you define parametric points at the attachment points of the cylinders 

in the model level and link (connect) those parametric points to certain parametric points in 

the subsystems. 

To define the parametric points at the model level: 

1. From the Parameter group in the 

SubEntity tab, click the 

Parametric Point (PP).  

2. Create four parametric points and 

fill in the text boxes as shown in 

the figure and as explained below. 

▪ Click Add four times. 

▪ Name the first point as 

PP_RCyl and the second 

point as PP_RRod. 

▪ Assign the first point the 

coordinates of  

-1460, 440, 650 and the 

second point the coordinates 

of -315, 260, 650. 

▪ Copy the data from the first 

point to the third point and 

the data from the second 

point to the fourth point. Change the R to L in the names as needed to indicate Left 

rather than Right. Change the sign of the Z-coordinates to be negative to put 

the third and fourth points on the other side of the chassis. 

3. Click OK to create the points and exit the Parametric Points window. 

To link the parametric points and position the hydraulic cylinders: 

1. From the Parameter group in the 

SubEntity tab, click the Parametric 

Point Connector (PPC). 

2. In the Parametric Point 

Connector List window, click Add 

four times.  

3. Name the first connector PPC_RCyl and the second point PPC_RRod. 

4. Click the Pt button for the first connector and drag the name PP_RCyl parametric point 

by using the mouse or input directly the position information in the Input window 

Toolbar. 

  



L O W - M O B I L I T Y  T R A C K E D  V E H I C L E  T U T O R I A L  ( T R A C K _ L M )  

 

40 

 

5. Click the … button.  

▪ The Find Parametric 

Connector 

References dialog 

box appears. 

6. Click >> in the lower right 

corner. 

▪ The Search dialog 

box appears. 

7. Check the box for 

PP_Cyl_End for the 

Right_Cyl subsystem. 

Then, click the Load button. 

8. Click Close in the Find Parametric Connector References dialog box. 

9. Create four parametric points and fill in the text boxes as shown in the figure and as 

explained below. 

Parametric Point 

Connector 

Parametric Point Name 

(model level) 

Parametric Point Name 

(subsystem level) 

PPC_RCyl PP_RCyl PP_Cyl_End@Right_Cyl 

PPC_RRod PP_RRod PP_Rod_End@Right_Cyl 

PPC_LCyl PP_LCyl PP_Cyl_End@Left_Cyl 

PPC_LRod PP_LRod PP_Rod_End@Left_Cyl 

 

10. Click OK to close the Parametric Point Connector List window and create the 

connectors.  

The two cylinders are now located in the proper locations. 
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Adjusting Size, Colors, and Motion of Hydraulic Cylinders 

Now that the hydraulic cylinders are in position, it is easy to see that the size of the cylinder 

components is too small. You should also adjust the color of the components to match the 

bulldozer. Finally, you need to add a motion input to the translational joint to contract the 

hydraulic cylinders by 100 mm so that the blade is in a transport position. 

To adjust the size of the components of each hydraulic cylinder: 

1. Enter the Edit mode for one of the hydraulic cylinders.  

2. Edit the Parametric Values for the hydraulic cylinder subsystem: 

▪ Set PV_Cyl_Radius to 60. 

▪ Set PV_Rod_Radius to 30. 

To adjust the color of the components of each hydraulic cylinder: 

1. Display the Properties window for Body1 (cylinder rod) and change the color to Gray-

25%.  

2. Display the Properties window for Body2 (upper cylinder) and change the color to 

yellow.  

To adjust the motion of each hydraulic cylinder: 

1. Display the Properties window for joint TraJoint1.  

2. In the Joint tab, click Include Motion and click Motion.  

3. Click EL to display the Expression List window.  

4. Click Create to display an Expression window.  

▪ Change Name to Exp_Cyl_Length  

▪ Enter STEP(TIME, 0.1, 0.0, 0.5, -100) in the text box.  

▪ Click OK to exit the Expression window.  

5. With Expression 7 selected, click OK to exit the Expression List window.  

6. Click OK to exit the Motion window.  

7. Click OK to exit the TraJoint1 window.  

8. Click the Exit arrow to return to the assembly mode.  

9. Repeat steps 1 through 12 above for the other cylinder. 
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Defining Constraints for the Blade Assembly 

In this section, you will create two revolute joint, four spherical joints, a CMotion constraint, 

and a pair of bushings to properly attach the blade assembly components to each other and 

to the chassis. 

To define the constraints:  

▪ Using the tools of the Joint group in the Professional tab, create the following joints as 

specified in the table below. Use the Body, Body, Point option to make sure that you are 

referencing the correct set of bodies, especially when one of them is within one of the two 

hydraulic cylinder subsystems (see tip below). 

Tip: You will notice that when creating a joint, force, or contact; you cannot select a body that 

is within a subsystem in the normal fashion. However, if you first press down on the Shift key, 

you will find that are able to select the body with the subsystem. 

   

Create the 

connection of type 

First Body Second Body At the location 

Joints:    

Revolute Chassis Body2@Right_Cyl -1460, 440, 650 

Revolute Chassis Body2@Left_Cyl -1460, 440, -650 

Spherical Chassis Right Rail -1775, -90, 650 

Spherical Chassis Left Rail -1775, -90, -650 

Spherical Body1@Right_Cyl Right Rail -315, 260, 650 

Spherical Body1@Left_Cyl Left Rail -315, 260, -650 

CMotion Right Rail Blade 885, -130, 0 

(for both points) 

Forces:    

Bushing Right Rail Blade 659, -280, 650 

Bushing Left Rail Blade 659, -280, -650 
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Adjust the CMotion to fix the blade angle:  

1. Display the Properties dialog box for CMotion1. 

2. Set the Cartesian Motion Type to Displacement (time) and RZ.  

3. Create an expression that has a constant_angle_of_zero (0.0). 

To test the full vehicle model with the blade assembly: 

▪ Run a simulation for 5 seconds and 250 steps and compare the animation and plot results 

to those of the previous animation.  

You should observe that the blade rises up to a transport position and then remained fixed 

as the bulldozer traverses the terrain. You may notice a small vertical motion of the blade 

relative to the linkage when the bulldozer hits the terrain near the beginning of the 

simulation. This is due to the compliance of the bushings. 

Do you observe any difference in the overall behavior of the bulldozer? You should not see 

any large changes in behavior, but small changes due to the forward transfer of the center 

of gravity of the bulldozer due to the weight of the blade assembly. You could plot the 

vertical loads at the sprocket and the idler for the two cases and see the effect of the 

weight transfer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Thanks for participating in this optional exercise! 
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